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® no power supply is provided by B2B connectors.

In this case, other components (e.g. extension or carrier boards) may also be
powered by the corresponding 5 volt line (5V) of B2B connector J5.

2.2.3 On-board Power Rails

Three on-board voltage regulators provide the following power supply rails
needed by the components on the module:

® 1.2V, 3.0 Amax
® 2.5V, 0.8 Amax
e 3.3V, 3.0 Amax
® 1.5V, 1.0 Amax

Figure 3 show power supply diagram.
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Figure 3: TE0630 Power diagram

The power rails are available for the FPGA and can be shared with a carrier
board by the corresponding lines of the B2B connectors J4 and J5. Please
note that the power consumption of the FPGA is highly dependent on the
design actually loaded. So please use a tool like Xilinx Xpower to estimate the
expected power consumption of your design.

Even if the provided voltages of the module are not used on the carrier board, it
is recommended to bypass them to ground with 10 nF - 100 nF capacitors.

FPGA 1/O banks power supply

Spartan-6 architecture organizes 1/Os into four I/O banks, see Table 1 for supply
voltage used for each bank.

VCCIOO voltage can be configured in 3 ways:

® 2.5V - When resistor R103 is populated and resistor R102 is not
populated.

® 3.3V - When R103 is not populated and resistor R102 is populated.
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2.4 Board-to-board Connectors

The module has two B2B (board-to-board) receptacle connectors (J4 and J5)
for a total of 160 contacts. Figure 6 shows B2B connectors location on board;

USB connector is located on the top side and is shown to define module
position.

Figure 6: B2B connectors location

TEO0630 uses high-density shockproof connectors shown in Figure 7. Connector
part numbers are listed in Table 4.

Figure 7: Module connector

Supplier Header
H11113CT-ND
Digikey H11113TR-ND
H11113DKR-ND
Hirose DF17(3.0)-80DS-0.5V(57)
Trenz Electronic 22684

Table 4: Module connectors part numbers

The on-board receptacles mate with their corresponding headers on the carrier

board shown in Figure 8. Ordering numbers of mating connectors are listed in
Table 5.
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Signal name FPGA pin

FDO J6

FD1 H8

FD2 H5

FD3 H6

FD4 G7

FD5 G8

FD6 F8

FD7 A3
24MHZ1 G3
PAO/INTO D1
PA1/INT1 D2
PA2/SLOE C1
PA3/WU E4
PA4/FIFOADDRO B1
PAS/FIFOADDRH1 C3
PAG/PKTEND B2
PA7/FLAGD/SLCS A2
RDY1/SLWR M3
RDYO/SLRD M4
CTL2/FLAGC E3
CTL1/FLAGB E1
CTLO/FLAGA F3
IFCLK N4

Table 7: USB controller interface: FPGA pin-out

2.11 Clock Oscillators

Two clock oscillators are installed on the TE0630.

Clock oscillator U10 generates a 24 MHz clock signal for the FPGA and the
USB controller. This clock signal is used for synchronous communication
between FPGA and USB controller.

Clock oscillator U11 generates a 100 MHz? clock signal used as a main system
clock in FPGA designs. See Table 8 for pin-out information.

Signal Frequency FPGA pin
24MHZ1 24 MHz G3
SYSCLK 100 MHz AA12

Table 8: Clock signals pin-out

2.12 LEDs
TE0630 is equipped with four active-high LEDs. See Table 9 for details.

3 Oscillator frequency can be changed by user request. Contact Trenz Electronic for details.
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Signal name FPGA pin LED
U_LED1 F1 D3
U_LED2 F2 D5
U_LED3 J4 D6
U_LED4 K8 D7

Table 9: LEDs pin-out

2.13 Push-Button

TE0630 module is equipped with one active-high push-button (signal is set to
logical "1" when button is pressed). Table 10 show push-button connection

details.
Signal name FPGA pin PB
PB R7 S5

Table 10: Push button pin-out

2.14 DIP Switch

On-board 4xDIP switch S1 used for system and user settings.

Switch 1 (S1A) is used to connect the USB controller to the 1°C serial EEPROM.
When S1Ais "ON", serial I>°C EEPROM is connected to the USB controller,
when switch is "OFF", the USB controller is disconnected from the EEPROM*.
Turn S1A off when programming the USB EEPROM (storing the USB vendor ID
and device ID). This will force the USB controller to provide its default vendor ID
and device ID.

Switch 2 (S1B) is used to control DC-DC converters. When switch is "OFF",
converters are controlled by the USB controller. When switch is "ON",
converters are enabled regardless of USB controller actions. At start-up, the
USB controller switches off 1.2V, 1.5V and 2.5V power rails and starts up the
module in low-power mode. After enumeration, the USB controller firmware
switches the 1.2V, 1.5V and 2.5V power rails on, if enough current is available
from the USB bus.

Switches 3 (S1C) and 4 (S1D) can be used as user switches. Switches are
active-low. Pull-up resistors should be defined in user constrains file (UCF) to
use this switches in FPGA design. See Table 11 for details.

Signal name FPGA pin Switch
I0_L61_N_1 AB21 S1C
I0_L63_N_1 AA22 S1D

Table 11: DIP switch pin-out

2.15 Board revisions and assembly variants

To determine PCB revision and assembly variant from FPGA, TE0O630 have
dedicated user signals, which can be read by user core.

Board revision coded in 4 bits BR[3:0]

4 Zero-resistor R90 (not populated by default) short this switch and connect EEPROM regardless of S1A position.
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Signal name FPGA pin

BRO R19
BR1 V19
BR2 V20
BR3 T17

Table 12: Board revision pins

To define low (zero) level BR pin connected to ground rail, to define high (one)
level BR pin left float (open). These pins should be configured with "pullup”
option in user design.

See Table 12 for current list of board revisions.

BR3 BR2 BR1 BRO
0 0 0 0 00 Initial revision

Table 13: Board revisions

Module assembly variant encoded using AV[3:0] pins.

Signal name FPGA pin

AVO Y20
AV1 R15
AV2 R16
AV3 R17

Table 14: Assembly variants pins

To define low (zero) level AV pin connected to ground rail through zero resistor,
to define high (one) level AV pin left float (open). These pins should be
configured with "pullup" option in user design.

Available module assembly variants listed in Table 15.

AV3 AvV2 AV1 AV0

0 0 0 0 Base assembly variant

Table 15: Module assembly variants

3 TE0300 compatibility

TE0630 module designed to be compatible with TE0300 board by main
mechanical and electrical characteristics.

3.1 Mechanical compatibility

Both modules have the same board dimensions. TE0630 mount holes and B2B
connectors locations are match with TE0300. See chapter 1.2 Dimensions for
detailed information.

TEO300 and TE0630 uses same B2B connectors types. In chapter 2.4 Board-
to-board Connectors you can find B2B connectors part numbers and main
characteristics.

3.2 Electrical compatibility

TEO0300 and TE0630 have similar power requirements and matched power
input pins. User signals to B2B connectors routed as differential pairs and single
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ended lines. Differences in pin types shown in Table 16, not listed signals have
same or compatible® type.

Connector:Pin TE0300 pin name TEO0300 Type TEO0630 pin name TE0630 Type

J4:5 B3_LO1_P DIO V3_l0_01 slo
Ja:7 B3_L01_N DIO V3_10_02 slo
J4:9 B3_L02_P DIO V3_l0_03 slo
Ja:11 B3 _L02_N DIO V3_l0_04 sIo
J4:17 BO_L24 N DIO V0_IO_01 slo
Ja:19 BO_L24 P DIO V0_I0_01 N DIO
J4:6 B3 _LO7_P DIO V3_l0_06 slo
J4:8 B3_LO7_N DIO V3_l0_07 slo
J4:10 B3_L03_N DIO V3_I0_08 slo
Ja:12 B3_L0O3_P DIO V3_l0_09 slo
J5:13 B3 L22 P DIO V3_10_12 sIo
J5:15 B3 L22 N DIO V3_10_13 slo
J5:19 B3 _L20_P DIO V3_10_14 sIo
J5:21 B3 _L20 N DIO V3_10_15 slo
J5:16 B3_L21 N DIO V3_10_17 sIo
J5:18 B3 L21 P DIO V3 10_18 slo
J5:20 B3_L23 N DIO V3_10_19 slo
J5:22 B3 L23 P DIO V3_I0_20 sIo
J5:32 B2_L06_P DIO V3_l0_24 slo
J5:34 B2_L06_N DIO V3_l0 25 sIo
J5:41 B2_GCLK13 clo V2_10_02 slo
J5:49 B2_GCLK_L13_N clo V210 24 P DIO
J5:51 B2_GCLK_L13_P clo V2 10 24 N DIO

Table 16: TE0300 and TE0630 pin types differences.
See Table 17 for pin types definitions.

Type
colour code

DIO

Description

Unrestricted, general-purpose differential user-1/0O pin.

SIO

Unrestricted, general-purpose user-1/O pin.

CIO

Unrestricted, general-purpose differential user-1/O pin. This pin also can be used as FPGA clock input.

Table 17: TE0300 and TE0630 pin types

Most user signals to B2B connectors routed from same FPGA banks.
Differences shown in Table 18.

5 Signals routed as differential pairs can be used as single ended.

16/39 www.trenz-electronic.de TE0630 Spartan-6 FPGA Industrial Micromodule



http://www.trenz-electronic.de/

3 TEO300 compatibility UM-TE0630 (v 0.21) 3 July 2013

Connector:Pin TEO0300 Bank TE0630 Bank
J4:15
J4:36
J4:52
J5:33
J5:28
J5:30
J5:32
J5:34
J5:38
J5:40
J5:42
J5:50
J5:52

Table 18: TE0300 and TE0630 user signals /O banks differences.
I/O Banks power supply for both modules shown in Table 19.

o
w

N ININ WO W W Ww w w w w

W W W W dMNININMNINMNINMINIO|O

N

Bank TE0300 TE0630
BO VCCIO (1.2V-33V) | VCCIO (12V-33V)
B1 25V 15V
B2 3.3V 3.3V
B3 3.3V 3.3V

Table 19: TE0300 and TE0630 FPGA I/O banks power supply.

Bank 0 1/0 supply voltage at both modules can be configured by user, see
chapter 2.2.3 On-board Power Rails.

4 Module Configuration
Full module configuration cycle (for just assembled board) include steps:
Generic USB driver installation
USB microcontroller large EEPROM programming
EEPROM programming

W=

Dedicated driver installation
5. SPI Flash configuration

Steps 1-3 already performed at Trenz Electronic laboratory, and not required
to perform by end user.

To work with TE0630 module using USB interface user should install dedicated
USB driver, which provide API to work with main module functions, for complete
instructions see chapter 5.2 Dedicated driver installation.

The FPGA on the TE0630 can be configured by SPI Flash or by JTAG
connector.

4.1 JTAG FPGA Configuration

Programming using JTAG interface provide convenient and fast way to test
FPGA project. FPGA configuration programmed this way is volatile and lost
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after reset or power cycle.

4.2 SPI FPGA Configuration

The bit-stream for the FPGA is stored in the SPI Flash. To use this bit-stream
source FPGA configuration option is set to “Master Serial/SPI”. See 2.8 SPI
Flash for additional information.

SPI Flash can be programmed in several ways:

® Direct programming by USB controller (usually done by Firmware Upgrade
Tool).

® Indirect SPI programming via FPGA pins, controlled by JTAG (can be done
using Xilinx IMPACT). See Appendix A. Indirect SPI Programming using
iMPACT.

® Direct SPI programming by FPGA, using an SPI core (FPGA project should
contain SPI interface core and software to work with it).

In SPI Flash mode, the FPGA’s internal oscillator generates the configuration
clock frequency. The FPGA provides this clock on its CCLK output pin, driving
the PROM'’s Slave Clock input pin. The FPGA begins configuring using its
lowest frequency setting. If so specified in the configuration bitstream, the FPGA
increases the CCLK frequency to the specified setting for the remainder of the
configuration process. The maximum frequency is specified using the
ConfigRate bitstream generator option. The maximum frequency supported by
the FPGA configuration logic depends on the timing for the SPI Flash device.
For TE0630 SPI Flash PROM, use ConfigRate = 12 or lower.

This options are set graphically in Xilinx ISE Software Project Navigator by
selecting the following:

® Generate Programming File > Process Properties > Configuration Options >
Configuration Rate > 12 (or lower)

4.3 eFUSE programming

To program eFUSE at TE0630 module follow the steps below.

® Connect 2.5V power rail to 3.3V power rail. It can be done on B2B connector
see 6 B2B Connectors Pin Descriptions. Or if module connected to
baseboard, better to short power rails on baseboard.

® Program eFUSE using JTAG cable and iMPACT software.

® Disconnect 2.5V and 3.3V power rails.

4.4 EZ-USB FX2 Firmware Programming

TE0630 module supplied with already programmed FX2 firmware, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

If the EEPROM has never been programmed before (virgin module) Switch 1
(S1A) can be switched to EEPROM (to "ON" state). See chapter 2.14 DIP
Switch for details. The USB microcontroller will detect an empty EEPROM and
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will provide its default vendor ID and device ID to the USB host. If the EEPROM
has been programmed before (EEPROM not empty), S1A must be switched to
"OFF". The USB microcontroller will detect a missing EEPROM and will provide
its default vendor ID and device ID to the USB host.

4.5 EZ-USB FX2 EEPROM Programming

TE0630 module supplied with already programmed EEPROM, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

First of all, check that Switch 1 (S1A) is actually switched to EEPROM. The
USB EEPROM can be programmed by opening the dedicated software
“Cypress USB Console” (double click the “CyConsole.exe” file in the
“1st_program\CyConsole” folder).

T Cypress USB Console

File ©Options Help
% [=] @ [x] Selected Script: X % (5 24/?

Select Device

USE Addrezz | Device Mame Mame in windows Device Mar [from .inf]

ienerc USE Device

Device Fropertties | Control Endpt Xfers] DtherEndthfers] Mizc. ]

VendorlD ... .. 0x04B4 Class .. ... O=FF
PraductD .. ... 0x8613 Subclass . . 04FF
M anufacturer . . . Protocal . . OxFF
Product. ... ... becdDevice OxA001

Serial Number . .

Device Configurations [ 1]
Yalue | Attributes | I i Piowwer |
0x01 080 0232 (100 ma)

Configuration Interfaces [4)

|t | Al Setting | Clazs | Subclazs Pratocol ~
u] u] 0xFF [ Wendor ] OxFF OxFF
] 1 0=FF [ Wendaor ) 0=FF 0=FF
] 2 0=FF [ Wendar ) 0=FF 0=FF hd

Interface Endpointz [ 0]
Address | Aftributes Max Pkt Size Irteryval

Click “Options > EZ-USB Interface” to Open EZ-USB Interface window.
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Hardwareinstallation

] ‘_\ Die Software, die fur diese Hardware installiert wird:
L]

Cypress Genenc USE Device

hat den *Windows-Logo-Test nicht bestanden, der die F.ompatibilitat mit
Windows XP Uberpriift. [warum izt disser Test wichti?]

Das Fortzetzen der Installation dieser Software kann die korrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microzoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software, die den
Windows-Logo-Test bestanden hat, in Yerbindung zu setzen.

| Installation fortsetzen | ’ Installation abbrechen

Assistent fiir das Suchen neuer, Hardware

Fertigstellen des Assistenten

Die Software fur die folgende Hardware wurde ingtalliet;

=

Cyprezz Generic USE Device

Klicken Sie auf "Fertig stellen”, um den Yargang abeuschlisfen.
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g Gerdte-Manager

Datei  Akbion  Ansicht 2

B EE 2 A <=<n8

+ @ Prozessoren
+-%g Speichervolumes
+ _} Systemgerste
+)-4 Tastaturen
= E&D USB-Corkroller

& Ca-200
2 s Genetic LISE Device
R ICHS Family USE Universal Host Controller - 2830
R} ICHS Family USE Universal Host Contraller - 2831
R ICHS Family USE Universal Host Controller - 2832
R ICHE Family USE Universal Host Controller - 2834
82 IntelfR) ICHS Family 1SB Universal Host Controller - 2835
82 IntelfR) ICHS Family 11SB2 Enhanced Host Contraler - 2536
2 IntelfR) ICHE Family 10582 Enhanced Host Controller - 2834
8% USB-Rook-Hub
& USB-Raot-Hub
8% USB-Rook-Hub
& USB-Root-Hub
8% USB-Rook-Hub
82 USB-Root-Hub
8% USB-Rook-Hub

& Intel
& Intel
&2 Intel
& Intel

After that I>°C EEPROM should be programmed with right Vendor ID / Device
ID, see chapter 4.5 EZ-USB FX2 EEPROM Programming.

5.2 Dedicated Driver

This driver used to work with modules which have DEWESoft firmware and
Vendor ID / Device ID programmed. All TEO630 modules supplied with
programmed USB controller and corresponding Vendor ID / Device ID in

EEPROM.

Before connect USB cable, check that Switch 1 (S1A) is on "ON" state (USB
controller connected to EEPROM).

Connect USB cable and wait until the operating system detects new hardware
and starts the hardware assistant and answer the hardware assistant questions
as shown in the following example.

www.trenz-electronic.de
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Assistent fiir das Suchen neuer Hardware

Fertigstellen des Assistenten

Die Saftware fur die folgende Hardware wurde installiert:

g

DEWESaft USE Device

Klicken Sie auf "Fertig stellen'’, um den Yorgang abzuzchliefen.

| Fertig stelen |

Check that in the “Device Manager” under “USB-Controller” the “DEWESoft

USB Device 0” has been added.

g Gerite-Manager.

Datei  Aktion  Ansicht 7

mE 2 A

+ m Prozessaren
+-age Speichervolumes
+ j Systemgerite
+-i Tastaturen
= %9 U3B-Contraller
& CA-200
&5 DEWESoft USE Device 0
&5 Intel(R) ICHE Family 1USE Universal Host Controller - 2530
&% Intel(R) ICHS Family LUSE Universal Host Contraller - 2831
&5 Intel(R) ICHE Family 1USE Universal Host Controller - 2532
&5 Intel(R) ICHE Family 1USE Universal Host Controller - 2534
&5 Intel(R) ICHE Family 1USE Universal Host Controller - 2535
&5 Intel(R) ICHE Family 1SE2 Enhanced Host Controller - 2836
&5 Intel(R) ICHE Family 10SE2 Enhanced Host Controllsr - 2834
&2 LSE-Rook-Hub
&5 USE-Rook-Hub
&5 USE-Rook-Hub
&5 USE-Rook-Hub
&5 USE-Rook-Hub
&5 USE-Rook-Hub
&2 LSE-Rook-Hub

6 B2B Connectors Pin Descriptions

This section describes how the various pins on B2B connectors J4 and J5 are
connected to TE0630 on-board components. There are four main signal types

connected to B2B connectors:
® FPGA users signals;

® USB signals;

® Power signals;

® System reset signals.
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6.1 Pin Labelling

FPGA user signals connected to B2B connectors are characterized by the
"Vx_IO_yy p" naming convention, where:

® Vx defines the FPGA bank (x = bank number);
® |0 defines an "FPGA to B2B" signal type;
® yy defines a differential pair or signal number (yy = pair number);

® p defines a differential signal polarity (P = positive, N = negative); single
ended signals do not have this field.

Remaining signals use custom names.

6.2 Pin Types

Most pins of B2B connectors J1 and J2 are general-purpose, user-defined 1/0
pins (GPIOs). There are, however, up to 5 different functional types of pins on
the TE0630, as outlined in Table 20. In pin-out tables Table 21 and Table 22, the
individual pins are colour-coded according to pin type as defined in Table 20.

type

T description

DIO Unrestricted, general-purpose differential user-1/0 pin.

SIO Unrestricted, general-purpose user-1/0 pin.

ClO Unrestricted, general-purpose differential user-1/O pin. This pin also can be used as FPGA clock input.
usSB USB signals.
JTAG Dedicated JTAG signals.

GND Dedicated ground pin. All must be connected.

sYs System sigr_1a|. $ee the description of each pin in the user manual for additional information on the

corresponding signals.
POW Power signals.

Table 20: TE0630 pin types
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6.5 Signal Integrity Considerations

Traces of differential signals pairs are routed symmetrically (as symmetric
pairs).

Traces of differential signals pairs are NOT routed with equal length®. For
applications where traces length has to be matched or timing differences have
to be compensated, Table 21 and Table 22 list the trace length of 1/O signal
lines measured from FPGA balls to B2B connector pins.

Traces of differential signals pairs are routed with a differential impedance
between the two traces of 100 ohm. Single ended traces are routed with 60
ohm impedance.

An electronic version of these pin-out tables are available for download from the
Trenz Electronic support area of the web site.

7 Related Materials and References

The following documents provide supplementary information useful with this
user manual.

7.1 Data Sheets
® Winbond W25Q64BV product overview.

http://www.winbond.com.tw/hg/enu/ProductAndSales/ProductLines/FlashMe
mory/SerialFlash/W25Q64BV.htm

® Xilinx DS160: Xilinx Spartan-6 Family overview
http://www.xilinx.com/support/documentation/data_sheets/ds160.pdf

® Cypress EZ-USB FX2 Controller datasheet
http://www.cypress.com/?mpn=CY7C68013A-56LTXC

7.2 User Guides
® Xilinx UG380: Spartan-6 FPGA Configuration User Guide

http://www.xilinx.com/support/documentation/user_guides/ug380.pdf
® Xilinx UG381: Spartan-6 FPGA SelectlO Resources

http://www.xilinx.com/support/documentation/user_guides/ug381.pdf

8 Glossary of Abbreviations and Acronyms

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly
performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a WARNING
notice until the indicated conditions are fully understood and met.

6 Difference in signal lines length is negligible for used signal frequency.
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API
B2B
DSP
EDK
0B

ISP
PB
SDK
TE
XPS

A CAUTION notice denotes a risk. It calls attention to an operating procedure, practice, or the like that, if not correctly
performed or adhered to, could result in a fault. (undesired condition that can lead to an error) Do not proceed beyond a
CAUTION notice until the indicated conditions are fully understood and met.

application programming interface
board-to-board

digital signal processing; digital signal processor
Embedded Development Kit

input / output blocks; 1/0 blocks

intellectual property

In-System Programmability

push button

Software Development Kit

Trenz Electronic

Xilinx Platform Studio

9 Legal Notices

9.1 Document Warranty

The material contained in this document is provided “as is” and is subject to
being changed at any time without notice. Trenz Electronic does not warrant the
accuracy and completeness of the materials in this document. Further, to the
maximum extent permitted by applicable law, Trenz Electronic disclaims all
warranties, either express or implied, with regard to this document and any
information contained herein, including but not limited to the implied warranties
of merchantability, fitness for a particular purpose or non infringement of
intellectual property. Trenz Electronic shall not be liable for errors or for
incidental or consequential damages in connection with the furnishing, use, or
performance of this document or of any information contained herein.

9.2 Limitation of Liability

In no event will Trenz Electronic, its suppliers, or other third parties mentioned in
this document be liable for any damages whatsoever (including, without
limitation, those resulting from lost profits, lost data or business interruption)
arising out of the use, inability to use, or the results of use of this document, any
documents linked to this document, or the materials or information contained at
any or all such documents. If your use of the materials or information from this
document results in the need for servicing, repair or correction of equipment or
data, you assume all costs thereof.

9.3 Copyright Notice

No part of this manual may be reproduced in any form or by any means
(including electronic storage and retrieval or translation into a foreign language)
without prior agreement and written consent from Trenz Electronic.
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9.4 Technology Licenses

The hardware / firmware / software described in this document are furnished
under a license and may be used /modified / copied only in accordance with the
terms of such license.
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10 Environmental Protection

To confront directly with the responsibility toward the environment, the global
community and eventually also oneself. Such a resolution should be integral
part not only of everybody's life. Also enterprises shall be conscious of their
social responsibility and contribute to the preservation of our common living
space. That is why Trenz Electronic invests in the protection of our
Environment.

10.1 REACH (Registration, Evaluation, Authorisation and Restriction of
Chemicals) Compliance Statement

Trenz Electronic is a manufacturer and a distributor of electronic products. It is
therefore a so called downstream user in the sense of REACH. The products
we supply to you are solely non-chemical products (goods). Moreover and
under normal and reasonably foreseeable circumstances of application, the
goods supplied to you shall not release any substance. For that, Trenz
Electronic is obliged to neither register nor to provide safety data sheet.

According to present knowledge and to best of our knowledge, no SVHC
(Substances of Very High Concern) on the Candidate List are contained in our
products.

Furthermore, we will immediately and unsolicited inform our customers in
compliance with REACH - Article 33 if any substance present in our goods
(above a concentration of 0,1 % weight by weight) will be classified as SVHC by
the European Chemicals Agency (ECHA).

10.2 RoHS (Restriction of Hazardous Substances) compliance
statement

Trenz Electronic GmbH herewith declares that all its products are developed,
manufactured and distributed RoHS compliant.

10.3 WEEE (Waste Electrical and Electronic Equipment)

Information for users within the European Union in accordance with Directive
2002/96/EC of the European Parliament and of the Council of 27 January 2003
on waste electrical and electronic equipment (WEEE).

Users of electrical and electronic equipment in private households are required
not to dispose of waste electrical and electronic equipment as unsorted
municipal waste and to collect such waste electrical and electronic equipment
separately. By the 13 August 2005, Member States shall have ensured that
systems are set up allowing final holders and distributors to return waste
electrical and electronic equipment at least free of charge. Member States shall
ensure the availability and accessibility of the necessary collection facilities.
Separate collection is the precondition to ensure specific treatment and
recycling of waste electrical and electronic equipment and is necessary to
achieve the chosen level of protection of human health and the environment in
the European Union. Consumers have to actively contribute to the success of
such collection and the return of waste electrical and electronic equipment.
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Presence of hazardous substances in electrical and electronic equipment
results in potential effects on the environment and human health. The symbol
consisting of the crossed-out wheeled bin indicates separate collection for

waste electrical and electronic equipment.
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5 st 0o ey I -]

.@ File Edit View Operations Output Debug  Window Help IZ"EIE
DAH #$ DX m%: 2832 =T AN
IMPACT Flows a=N-53

Right click device to select operations

- 59 Beundary Scan

o |2] Create PROM File (PROM File Format... Veri
: eri
G- [Z] WebTalk Data O — JEx v
Erase
Blank Check
xcist
Readback...
by ,
TDO Get Device Checksum
iMPACT Processes 08 X ] ] ] ]
- - Assign Mew Configuration File...
Available Operations are: -
= Program e
=P Verify Set Programming Properties...
=P Erase Set Erase Properties...

md Blank Check
m) Readback

=) Get Device Checksum A8 '@ Boundary  Launch File Assignment Wizard

i, Dmmel Mhmssimm Cmdare

Edit Attached Flash Properties..,

Conzole +0F X

iy INFO:iMPACT — A CFI file is not detected. To ensure correct and safe conf »
Flease make sure a CFI file is present in the same directory as the PROM
or, regenerate the PRCOM file with the latest software.

=
i
« m .
Console Fé Errors |_|‘}. Wam'rr1gs|

|Com‘iguration |P|atform Cable USB |6MH2 |_|usb-h5

Leave default programming properties and press “OK”.

@ Device Programming Properties - Device 1 Progra

Category

= Boundary-5can
- Device1 [ FPGA xc3s1200e ) Property Name
Devicel [ Attached FLASH, M25P3 Verify

Design-Specific Erase Before Programming

After programming Flash... automatically load FPGA with

Wait for operation to complete.
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